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ModusToolbox™ tools package version 3.1.0

About this document

Scope and purpose

ModusToolbox™ software is a set of tools and libraries that support device configuration and application
development. These tools enable you to integrate our devices into your existing development methodology.
This document provides information and instructions for using Keil pVision with ModusToolbox™ software.

Document conventions

Convention Explanation

Bold Emphasizes heading levels, column headings, menus and sub-menus.

Italics Denotes file names and paths.

Courier New Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder names,
directories, command line inputs, code snippets.

File > New Indicates that a cascading sub-menu opens when you select a menu item.

Reference documents

Refer to the following documents for more information as needed:

e ModusToolbox™ tools package installation guide —Provides information and instructions about installing
the tools package on Windows, Linux, and macOS.

e ModusToolbox™ tools package user guide —Provides information about all the tools included with
ModusToolbox™ tools package.

e Dashboard user guide -Provides specific information about the Dashboard tool.

e Project Creator user guide -Provides specific information about the Project Creator tool.

e Device Configurator guide -Provides specific information about the Device Configurator.
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Download/install software

1 Download/install software

1.1 ModusToolbox™ tools package

Refer to the instructions in the ModusToolbox™ tools package installation guide for how to download and
install the ModusToolbox™ tools package.

1.2 Keil pVision (Windows only)

Keil yVision version 5.30 or later

1.3 Python

Python 3.8 is installed in the tools_3.x directory, and the make build system has been configured to use it. You
don't need to do anything if you use the modus-shell/Cygwin.bat file to run command line tools.

However, if you plan to use your own version of Cygwin or some other type of bash, you will need to ensure
your system is configured correctly to use Python 3.8. Use the CY PYTHON PATH as appropriate.

1.4 J-Link

For J-Link debugging, download and install J-Link software:

https://www.segger.com/downloads/J-Link/J-Link Windows.exe
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2 Getting Started

This section covers the ways to get started using IAR Embedded Workbench with ModusToolbox™ software.

e Create new application

e Exporting existing application

e Open application Keil yVision

2.1 Create new application

Creating an application includes several steps, as follows:

2.1.1 Step 1: Open Project Creator tool

The ModusToolbox™ Project Creator tool is used to create applications based on code examples and template
applications. You can open the Project Creator tool from the Windows Start menu, or by launching the
executable. By default, the tool is installed in the following directory:

<user_home=>/ModusToolbox/tools_<version>/project-creator
The tool is provided in GUI form and as a command line interface. For more details, refer to the Project Creator

user guide.

Note: You can also launch the Project Creator tool from the ModusToolbox™ Dashboard. Refer to the
Dashboard user quide for details.

2.1.2 Step 2: Choose Board Support Package (BSP)

When the Project Creator tool opens, expand one of the BSP categories under Kit Name and select an
appropriate kit; see the description for it on the right. The following image is an example; the precise list of
boards available in this version will reflect the platforms available for development. You can also create a new
BSP or browse for one on disk.

[& Choose Board Support Package (BSP) - Project Creator 2,10 - m} x
Settings  Help
Source Template
|Ente|‘fi|terte-t.” /7 || |Create from MPM...| |Browse for BSP... [= [ | CY8CKIT-06252-43012 =
Kit Mame MCU/SOC/SIP Connectivity # | | The CYBCKIT-06252-43012 PSoC™ 652 Wi-Fi BT
PSoC™ 4 BSPe Pioneer Kit is a low-cost hardware platform that
v PSoC™ £ BSPs enables design and debug of PSoC™ 6 MCUs, It
comes with a Murata 1LY Module (CYW43012
CYSCEVAL-06252 CYBCA24ABZI-52D44 <none» Wi-Fi + Bluetooth Combo Chip), industry-
CVBCEVAL-06252-LAI-43439M2  CYBCE24ABZI-52044 Sterling-LWB-+ (CYW43439KUBG) leading CAPSENSE™ for touch buttons and
CYBCEVAL-06252-LAI-4373M2 CY8CA2AABZI-52D44 Sterling-LWES+ (CYWA373EUBGT) slider, on-board debugger/pragrammer with
CYBCEVAL-06252-MUR-43439M2 CYBCE24ABZI-52D44 LBEESKLTYM (CYW43439KUBG) KitProg3, microSD card interface, 512-Mb Quad-
CYBCEVAL-06252-MUR-4373EM2  CYBCE24ABZ1-52D44 LBEESPKZAE (CYW43T3EUBGT) SPINOR flash, PDM-PCM microphone interface.
CYBCEVAL-06252-MUR-4373M2  CYBCB24AB71-52D44 LBEESPKZBC (CYW4373IUBGT) X
CYSCKIT-062-BLE CY8Ca347BZI-BLDS3 <none» Kit Features:
CYBCKIT-06252-43012 CYBCEA4ABZI-52D44 LBEES9BILV (CYW43012COWKWBG) * Support of up to 2MB Flash and 1MB
CYBCKIT-06254 CY3Ca244LC1-54D92 <none» SRAM
CYBCKIT-062-WIFI-BT CY¥BC6247BZ1-D54 LBEESKL1DX (CYW4343WKUBG) ® Dedicated SDHC to interface with WICED
CYSCKIT-064B0S2-4343W CYBOE44ABZI-S2D44 LBEESKL1DX (CYW4343WKUBG) Wi"_E|ESS devices. )
CYSCKIT-0645052-4243W CYSOE44ABZI-52D44 LBEESKL1DX (CYW4342WKUBG) . DE“V;’S dua'-f@ﬂfe& with 2 130-MHz
CY8CPROTO-062-4343W CYBCE24ABZI-52044 LBEESKL1DX (CYW4343WKUBG) " Arm® Cortex ®-M4 as the primary "
apnplication orocessor and a 100-MH

T

BSP: CYSCKIT-06252-43012

Press "Mext" to select application. v

Mext > Close

For this example, select the CYS8CKIT-062S2-43012 kit.
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. .
2.1.3 Step 3: Select application
Click Next > to open the Select Application page.
[ Select Application - Project Creator 2,10 — [m| *
Settings  Help
Application(s) Reot Path: | C:/Users/Test/mtw3.1/uvision Browse...
Target IDE: <None> ~
Enter filter text... /7 | Browse for Application... ' gg:j Bz B
Template Application Mew Application Mame  New BSP Name
Eluetooth®
Community Code Examples
Connectivity
Getting Started
Graphics

Machine Learning
Manufacturing
Peripherals
Sensing

Wi-Fi

Select one or more template applications to proceed with the new project creation process.

< Back Create

This page displays example applications, which demonstrate different features available on the selected BSP.
In this case, the CY8CKIT-06252-43012 provides the PSoC™ 62 MCU and the AIROC™ CYW43012 Wi-Fi &
Bluetooth® combo chip. You can create examples for PSoC™ 6 MCU resources such as CAPSENSE™ and QSPI, as
well as numerous examples for other capabilities.

Click Browse... next to Application(s) Root Path to create or specify a folder where the application will be
created.

Pull down the Target IDE menu, and select ARM MDK (uVision).

Application(s) Root Path: | Ci/Users/Test/mbw3.1/uvision Browse...
Target IDE: <Mone> w
<Mone=
|EntE|' filter text... Eclipse IDE for ModusToolbox™
Microsoft Visual Studic Code
- |AR Embedded Workbench
Template Applicat ; )
RSt . 1 1\1DK (uVision)
Bl ietanth @

Under the Template Application column, expand Getting Started and select Hello World from the list. This
example exercise uses the PSoC™ 6 MCU to blink an LED.

Template Application Mew Application Name Mew B5P Mame
“ (Getting Started
[] Dual-CPU Empty PSoCE App
[] Empty App
Hello World BEEREE | APP_CVBCKIT-06252-43012
[ security App
O Switching Power Modes

The actual application names available might vary.

Type a name for your application and/or BSP, or leave the default names. Do not use spaces. Also, do not use
common illegal characters, such as:

*."m Y/ N T s =y
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2.1.4 Step 4: Create application

Click Create to start creating the application. The tool displays various messages.

Q Select Application - Project Creator 2,10 -
Settings  Help
Application(s) Root Path: |C:/Users/Test/mtw3.1/uvision

Target IDE: <None>

Enter filter text... Browse for Application... = 0= B H

Template Application Mew Application Name New BSP Name
Connectivity
v Getting Started
Dual-CPU Empty PSoCt App
Empty App
Hello World
Security App

Helle_Werld APP_CYECKIT-06252-43012
Switching Power Modes

Graphics

Machine Learning

Manufacturing

Peripherals

Sensing

Wi-Fi

Browse...

]
warning: redirecting to https://gitlab.intra.infineon.com/repo-staging/TARGET_CYBCKIT-06252-43012.git/
warning: redirecting to https://gitlab.intra.infineon.com/repo-staging/retarget-io.git/

warning: redirecting to https://gitlab.intra.infineon.com/repo-staging/core-lib.git/

warning: redirecting to https://gitlab.intra.infineon.com/repo-staging/catlcmip.git/

= Back Create

Infineon

When the process completes, a message states that the application was created. Click Close to exit the Project

Creator tool.

0 errer(s), 0 warning(s)

Summary:

Successfully created and exported "Hello_World" application.

< Back

Create

Close

2.2 Export existing application

If you have a ModusToolbox™ application that was created for another IDE or for the command line, you can
export that application to be used in uVision. Open a terminal window in the application directory, and run the

command make uvision TOOLCHAIN=ARM.

Note: For applications that were created using core-make-3.0 or older, you must use the
make uvision5command instead.

Note: This sets the TOOLCHAIN to ARM in the Keil uVision configuration files but not in the
ModusToolbox™ application’s Makefile. Therefore, builds inside Keil uVision will use the ARM
toolchain while builds from the ModusToolbox™ environment will continue to use the toolchain
that was previously specified in the Makefile. You can edit the Makefile’s TOOLCHAIN variable if
you also want ModusToolbox™ builds to use the ARM toolchain.

Note: Check the output log for instructions and information about various flags.
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2.3 Open application in Keil pVision

Creating or exporting the application generates the following file in the application directory:
mtb-example-psocé-hello-world.cprj

The cprij file extension should have the association enabled to open it in Keil pVision.

1. Double-click the mtb-example-psoc6-hello-world.cprjfile. This launches the Keil pVision IDE. The first time
you do this, the following dialog displays:

Missing Required Packs

g™ Mot installed required packs for Project
| | mtb-example-psocs-hello-world':

Cypress.PSoC6_DFP.[

Do you want to install them?

2. Click Yes to install the device pack. You only need to do this once.

3. Follow the steps in the Pack Installer to properly install the device pack.

Pack Unzip: Cypress P5oC6_DFP 1.0.0 X

License Agreement

Please read the following license agreement carefully.

Ta continue with SETUP, yau must accept the terms of the License Agreement. To accept the
agreement, click the check box belov,

CYPRESS END USER LICEMSE AGREEMENT A~

FLEASE READ THIS EMD USER LICEMSE AGREEMEMT [“Agreement’) CAREFULLY BEFORE
DOWMLOADIMNG, INSTALLING, COPYIMG, OR USING THIS SOFT'wARE AMD
ACCOMPAMYIMNG DOCUMENTATION. BY DOWMLOADIMG, IMSTALLIMG, COPYIMG OR
USING THE S0OFTWARE, vOU ARE AGREEING TO BE BOUMD BY THIS AGREEMEMT. IF
wOU DO MOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, PROMPTLY RETURM WYision
AMND DO NOT USE THE SOFTWwWARE. IF vYOU HAYE PURCHASED THIS LICEMSE TO THE
SOFTWARE, YOUR RIGHT TO RETURMN THE SOFTWARE EXPIRES 30 DAYS AFTER YOUR .,
[~ | agree ta ar/\\ghe termns of the preceding License Agreement .'0’. Software Packs folder has been modified.
X " Reload Packs?

| | Cancel |

Mo
Note: In some cases, you may see the following error message:
SSL caching disabled in Windows Internet settings. Switched to offline mode.
See this link for how to solve this problem:
https://developer.arm.com/documentation/ka002253/latest
4. When complete, close the Pack Installer and close the Keil pVision IDE.
5. Then double-click the .cprjfile again and the application will be created for you in the IDE.
User guide 7 002-37570 Rev. *A
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3 Configure and

build the application

Infineon

1. Right-click on the mtb-example-psoc6-hello-world directory in the pVision Project view, and select Options

for Target '<application-name>' ...

K2 Colsers\wmed\mtb-example-psoch-hello-worldimth-example-psoch-hello-werld.uvprojx - pVision
File Edit View Project Flash Debug Peripherals Tools SVC5 Window Help
15 d @ % R | | | = = | &
L Ill @‘ | % mtb-example-psoct-helli|~ £Q| h ’ M_/ @
Praject [ x|
=% Project: mtb-example-ps
=45 mtb-example-psocs
5-E5 Source . Options for Target ‘'mtb-example-psoct-hello-world'... Alt+F7
1 main.c Add Group...
’ TARGET_CYBCP h Manage Project ltems...
& capsense % Rebuild all target files
¥ core-lib :
’ psoc6emOp l:%] Build Target F7
’ psocbhal ¥ | Show Include File Dependencies
& psoctpdl
& retarget-io

On the dialog, select the C/C++ (AC6) tab.

e Check that the Language C version was automatically set to c99.

e Select "AC5-like warnings" in the Warnings drop-down list.

e Select "-Os balanced" in the Optimization drop-down list.

e Toreduce memory usage, select the One ELF Section per Function check box.

KA Options for Target 'mtb-example-psocé-hello-world’

Preprocessor Symbols

Device] Target] Output ] Listing ] User C/C++(ACE) ]ﬁsm ] Linker ] Debug ] Ltilties ]

Define: |

Undefine: |

Language / Code Generation

[~ Execute-only Code

IWamings: ACHike Wamings -

I Language C: ’m I

IODiimization: |-Os balanced ﬂ I [ Tum vy unspeciied>

I [+ One ELF Section per Funcﬁonl

No Wamings
[~ Link-Time Optimization [~ [All Wamings
[ Split Load and Stare Muttiple I [MISRA Compatible

[~ Read-Write Position Independent

Language C++: |c++98 hd

¥ Short enums./'wchar
[~ use RTTI
[ No Auto Includes

bendent

Include |..'-rrdb-example-psocﬁhelloworld:.'-Jibs
Paths

=

Misc |
Controls

Compiler
control
string

fno-ti funsigned-char fshort-enums {fshort-wehar

e -std=c99 -target=am-amm-ione-eabi mopu=cortex-m4 mfpu=fpv4-sp-d1& mfloat-abi=hard ¢ -

s

Cancel

o ]|

Defaults

Help

User guide
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3. Select the Debug tab, and select KitProg3 CMSIS-DAP as an active debug adapter:

KA Options for Target 'mtb-example-psoct-hello-world' X
Device] Target ] Output ] Listing ] User ] CiCs= {.F\DE}] Asm ] Linker Debug ] Litilities ]
" Use Simulator  with restrictions Settings | * Use: |CMSIS—DAP Debugger ﬂ Settings |
[~ Limit Speed to Real-Time TLTNRANS Debugger A
CMSIS-DAF‘ Debugger
- - J-LINK / J-TRACE Cortex p
v v ]
[V Load Application at Startup ¥ Run to main() W Load Models Cortex-M Debugger b main{)
Initialization File: Initializatid S T-Link Debugger
’— MNULink Debugger
J Pemicro Debugger J
. ) Stellaris ICDI
Restore Debug Session Settings Restore Silahs UDA Debuager
¥ Breakpoints [V Toolbox [ BreAltera Blaster Cortex Debugger
T| %05 Deby
[+ Watch Windows & Peformance Analyzer WV Wier haews
W Memory Display [V System Viewer [ Memory Display ¥ System Viewer
CPU DLL: Parameter: Driver DLL: Parameter:
|SARMCM3.DLL |-REMAP -MPU SARMCM3.DLL | -MPU
Dialog DLL: Parameter: Dialog DLL: Parameter:
[DCM.DLL [pCM4 |TCM.DLL [pCM4
[ Wam if outdated Executable is loaded [ Wam if outdated Executable is loaded
Manage Component Viewer Description Files ... |
QK | Cancel | Defaulis | Help

4. Click OKto close the Options dialog.

5. Select Project > Build target.

Note: For applications using the PSoC™ 64 MCU, skip this step. Instead, perform the steps outlined in the

Build Output + B8
compiling cy_retarget ic.c... -
linking...

.\1ibs\TARGET CYSCPROTO-062-4343W\COMFONENI CM4\TOOLCHAIN ARM\CyScéxxa cmé_dual.sct (144): warning: Le€329W: Pattern *(.Cy ramfunc) only matches removed unused sections.
.\1ibs\TARGET CYSCPROTO-062-4343W\COMPONENT CM4\TOOLCHAIN ARM\cyScéxxa cm4 dual.sct (170): warning: L&314W: No section matches pattern *(.cy app signature).

\11ibs\TARGET_CYSCPROTO-062-4343W\COMPONENT_CM4\TOOLCHAIN_ARM\CyScexxa_cmé_dual.sct (18

-\1ibs\TARGET CYSCPROTO-062-4343W\COMPONENT CM4\TOOLCHATN ARM\cyScéxxa cmd_dual.sct (1

warning: L6314W: No section matches pattern *

X : warning: L6314W: No section matches pattern *
.\1ibs\TARGET CYSCPRCTO-062-4343W\CCMEONENT_CM4\TCOLCHAIN ARM\cyScéxxa_cmé4_dual.sct (158): warning: L6€314W: No section matches pattern *
\1ibs\TARGET CYSCPROTO-062-4343W\COMPONENT CM4\TOOLCHAIN ARM\cyScéxxa cmd4 dual.sct (207): warning: L&314W: No section matches pattern *

.cy_em_ssprom) .
.cy_sflash_user_data).
cy_sflash_nar) .
cy_sflash_public_key).
.Cy_toc_part2).
cy_rtoc_part).

-\1ibs\TARGET_CYSCPROTO-062-4343W\CCOMPONENT_CM4\TOOLCHATN ARM\cyScéxxa_cmd_dual.sct(216): warning: L6314W: No section matches pattern *

\1ibs\TARGET CYSCPROTO-062-4343W\COMPONENT CM4\TOOLCHATN) ARM\cy8céxxa cmd dual.sct(225): warning: L6314W: No section matches pattern *

.\1ibs\TARGET CYSCPROTO-062-4343W\CCMPONENT_CM4\TOOLCHAIN_ARM\cyScéxxa_cmé_dual.sct (235): warning: Lé314W: No section matches pattern *(.cy_xip).

.\1ibs\TARGET CYSCPROTO-062-4343W\COMPONENT CM4\TOOLCHAIN ARM\cyScéxxa cmd4_dual.sct (245): warning: Lé314W: No section matches pattern * (.cy_efuse) .

.\1ibs\TARGET CYSCPROTO-062-4343W\COMPONENT_ CM4\TCOLCHAIN ARM\cyScéxxa_ cm4_dual.sct (253): warning: L6€314W: No section matches pattern *(.cymeta).

Program Size: Code=19998 RO-data=8386 RW-data=440 ZI-data=1037896

Finished: 0 information, 1l warning and 0 error messages.

".\mtb-example-psocé-hello-world build\mtb-sxampls-psocé-hello-world.axf" - O Error(s), 11 Warning(s).

Build Time Elapsed: 00:01:31 .
CMSIS-DAP Debugger CAP NUM SCRL OVR R /W

To suppress the linker warnings about unused sections defined in the linker scripts, add "6314,6329" to the
Disable Warnings setting in the Project Linker Options.

3.1 PSoC™ 64 application configuration

Before building an application for a PSoC™ 64 secure MCU in Keil pVision, you must perform the following
configuration steps:

1. Build the application using the ModusToolbox™ make build command. You can do this by using a Terminal
or by exporting the application to Eclipse or VS Code.

User guide 9 002-37570 Rev. *A
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2. Copy the post-build command from the log. For example:

C:/Infineon/Tools/ModusToolbox/tools 3.1/python/python.exe C:/UG/CY8CPROTO-064S1-

SB_Secure Blinky LED FreeRTOS UG/bsps/TARGET APP CY8CPROTO-06451-5SB/psoc64 postbuild.py --
core CM4 --secure-boot-stage single --policy policy single CMO CM4 --target cyb06xx7 --
toolchain-path C:/Infineon/Tools/ModusToolbox/tools 3.1/gcc --toolchain GCC_ARM --build-dir
C:/UG/CY8CPROTO-064S1-SB Secure Blinky LED FreeRTOS UG/build/APP_CY8CPROTO-064S51-SB/Debug -
—app-name mtb-example-psoc6-secure-blinkyled-freertos --cmO-app-path

../mtb shared/catlcmOp/release-v1.0.0/COMPONENT CAT1A/COMPONENT CMOP SECURE --cmO-app-name
psoc6 01 cmOp secure

3. Paste the command into an appropriate editor, and make the following edits:

e Change --toolchain-path to the ARM toolchain; for example, C:/Keil_v5/ARM/ARMCLANG
e Change --toolchainto ARM
e Change --build-dir to Keil pVision build directory

Example of command after edit:

C:/Infineon/Tools/ModusToolbox/tools 3.1/python/python.exe C:/UG/CY8CPROTO-064S1~
SB_Secure Blinky LED FreeRTOS UG/bsps/TARGET APP CY8CPROTO-064S51-SB/psoc64 postbuild.py
--core CM4 --secure-boot-stage single --policy policy single CMO CM4 --target cyb06xx7
--toolchain-path C:/Keil v5/ARM/ARMCLANG --toolchain ARM --build-dir C:/UG/CY8CPROTO-
064S1-SB_Secure_Blinky LED_ FreeRTOS_UG/mtb-example-psoc6-secure-blinkyled-
freertos_Objects --app-name mtb-example-psoc6-secure-blinkyled-freertos --cmO-app-path
../mtb shared/catlcmOp/release-v1.0.0/COMPONENT CAT1A/COMPONENT CMOP SECURE --cmO-app-
name psoc6 01 cmOp_ secure

4. Copy the edited command.
5. InpVision, select Project > Options for Target 'Target 1'... to open the Options dialog.

6. Selectthe User tab and enable the Run #1 check box under After Build/Rebuild. Then, paste the edited

command.
KA oOptions for Target ‘Target 1' >
De\tice] Tanget ] Output ] UstinngCH {AEG}] Asm ] Linker ] Debug ] Ltilities ]
Command ltermns User Command .. Stopon Exi.. 5.

[=--Before Compile C/C++ File

[~ Run#1 (23] Mot Specified [

[~ Run#2 (23] Mot Specified ||
= Before Build/Rebuild

[~ Run# (23] Mot Specified ||

[~ Run#2 (2] Mot Specified ||
[=]--After Build/Rebuild

Run # Ci/Infineon,/Tools/ModusToolbox ftocls_3.1/pyt... _ﬂ Mot Specified |[

[~ Run#2 15| Mot Specified [

™ Bun 'After-Build’ Conditionally
v Beep When Complete [ Start Debugaging

QK | Cancel Defaults Help

User guide 10 002-37570 Rev. *A
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7. Select the Output tab and enable the Create HEX File check box.

KA options for Target Target 1'

Device ] Target IJsting ] User ] C/AC++ {PcC'En}l Asm ] Linker ] Debug ] Util'rtiesl

Name of Executable: |rntb-exam|:n|e-psocEﬂecure-blinkﬁen

Select Folder for Objects. .. |

+ Create Executable: mtb-example-psoch-secure-blinkyledfreerttos_Objects‘\mtb-example-psocG-secun
™ Create Batch File

[+ Debug Information

[+ Browse Information
" Create Library: \mth-example-psoct-secure-blinkyledfreertos_Objects'mtb-example-psoch-secure-blinkyled freert

QK | Cancel

Defaults | Help

8. Onthe same Output tab, add an ".elf" extension in the Name of Executable field.

s

KA oOptions for Target Target 1'
Device ] Target Output lleting ] User ] C/Ce+ {PcC'Eu}l Asm ] Linker ] Debug ] Util'rtiesl

Name of Executable: |:-|:|socB—secure-hlinkﬂed-freerlosEﬁ

Select Folder for Objects...

+ Create Executable: ‘mtb-example-psocB-secure-blinkyledfreerttos_Objects‘\mtb-example-psocG-secun

[+ Debug Information
[+ Create HEX Fil

[+ Browse Information

I Create Batch File

" Create Library: \mtb-example-psoc6-secure-blinkyledfreertos_Objects \mtb-example-psocB-secure-blinkyledfreert

| QK | | Cancel

==

9. Create an empty project.inifile in the project root folder.

User guide 11
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Configure and build the application

Infineon

10. On the Options dialog, select the Utilities tab and select the project.ini file using the [...] button. Then, click
Edit to open the file and click OK to close the options dialog.

KA options for Target ‘Target 1'

Corfigure Flash Menu Commanid
* Use Target Driver for lash Programming

— Use Debug Driver —

De\rice] Target ] Output ] Listing ] User ] CiCe= {AC'E}] Asm ] Linker ] Debug

W Use Debug Driver

Settings | W Update Target before Debugging

I Init File: |.'-project.ini

" Use Extemal Tool for Flash Programming

Command:l

Arguments: |
-

Configure Image File Processing (FCARM):
Output File:

Add Output File to Group:

SOUrces bl

Image Files Root Folder: |

[ Generate Listing

oK |

Cancel | Defaults | Help

11. Type LOAD $LGRL.hex inthe project.inifile and save the file.

j main.c _] y_pra.c D project.ini

1 [LOAD SLEL.hex

12. Select Project > Build Target to build the application and execute post-build commands.

After performing these steps, you should be able to run debug, erase, and program for PSoC™ 64 secure MCUs.

User guide

12

002-37570 Rev. *A
2023-06-02



Keil pVision for ModusToolbox™ user guide

Programming/Debugging

4 Programming/Debugging

1. Connectthe PSoC™ 6 kit to the host PC.

Infineon

2. Asneeded, run the fw-loader tool to make sure the board firmware is upgraded to KitProg3. See KitProg3
User Guide for details. The tool is located in this directory by default:

<user_home>/ModusToolbox/tools_3.1/fw-loader/bin/

3. Select Debug > Start/Stop Debug Session.

K Ci\Users\vmed\mtb-example-psocé-hello-werldimtb-example-psech-hello-world.uvpropx - pVision - O >
File Edit Wiew Project Flash Debug Peripherals Tools SVCS  Window Help
NMEA@| % B9 | @ | B BB R|EE/E/«LE B VR Q- e
HEO BTGy DR BEaRE O-B-0-0- B %
Registers a1 B Disassembly [ |
Register I Value I: Ox10006EDC 4770 BX ir -
Ox10006EDZ 00CO MCVS rd,zd
0x1000... oot R -
00800 101: cy_rslt_t result:
30000 102: /% Imitialize the device and board peripherals =/
30000, igz result = cybsp init();
(0000... e Se mm il Eoim o me i e s v
0 0000... LS >
0x1000...
0800, Ij main.c J cy_utils.h v X
(x0B00... a5 int ~
(x1000... ag
Ox1000... o T L T
0<E0D... 98 int main(void)
B R13(SP)  Dx0BOF .. [ 1] |__—_||{
e R14 (LR} Ox1000... 100 cy_rslt_t result;
R15(PC) Ox1000... 101
xPSR 0x6100... 102 /* Imitialize the device and board peripherals */
103 result = cybsp_init();
104
105 /* Board init failed. Stop program execution */
Thread | _| 106 if (result != CY RSLT_ SUCCESS)
[ - Tl P w
[iE] Project | =5 Registers L
Command o B call stack + Locals n B3
Load "C:\\Users\‘\wvmed\\mtb-example-psocé-hello-wo: Name Location/Value Type
= % main (e 10006ED4 int () -
< > ¥ result <not in scope> auto-uin'v
> 4| | _’I—I
ASS5IGN BreakDisable BreakEnable BreakKill BIeakListl Q;-ECallstack+Locals
CMSIS-DAP Debugger

User guide
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You can view the system and peripheral registers in the SVD view.

Ch\Users\vmed\mtb-example-psoch-hello-worldmtb-example-psoc-hello-world.uvprojx - pVision - O *
File Edit View Project Flash Debug | Peripherals Tools SVCS  Window  Help
IWEH@|.I—J@:|"? | System Viewer M BAckup ) vay&|@-|. @ﬁ'||E|'|‘K
= ' v | CPUss ]
Ros“-r|®| ™ "{}| d>| B Core Peripherals >|_| ] - Ev| i .
CsDo
Registers 2 El Disassembly [ a B crpuss O x |
0x10006EDC 4770 BX DMAC - e
0x10006ED2 0000 MOWVS Dw 4
og: | EFUSE Property Value
100: cy_rslt_t resi = IDENTITY e DDDDOFO3 ﬂ
101: FAULT
: p T
102: /* Imitialize FLASHC board peripherals *;
103: result = cybs] GRIO N5 |7
104: v PC 0x00
s Fe o iz HSIOM N G & el
< > MS 0xOF
[ YE = CM4_STATUS 000000010
_ ; x
L] mainc | | ] gLutils.h IPC M SLEEPING r
i L LCDO 2 SLEEPDEEP ]
a7 R R R R R R R R i R R R R R R R R "
98  int main(void) LPCOMP PAWR_DONE ¥l
: LNl Pass £ CM4_CLOCK CTL
) (xDBOFF3 100 cy rslt t res FAST_INT_DIV 000
) 0100023 101 - FOMO
102 # Initiali i b d ipt 1s *
ni ia :LZE. oard peripherals CMA_INTD_STATUS
103 result = cybs] PROFILE
e 104 CM4_INT1_STATUS
ini EROT uti Fe— |
105 /* Board init rogram execution */ L CRAA KT CTATIIE
106 if (result != SAR 5) FAST_INT_DIV ~
Thread -l 107 { SCB » [Bits 15..8] RW (@ 0x40200008) Specifies the
o2 B — 1nn v neawDT ¥ || fast clock divider (from the high frequency
&l Project | = Registers < SDHC 4 > clock 'clk_hf' to the peripheral clock w
Command SMARTIO For)r1 i |
Load "C:\\Users‘\‘\vmed\\mtb-example-psocé-hello-wor SMIFD iess‘l -
. |
SRSS
TCPWM 3
<
USBFSO
>
ASSIGN BreakDisable BreakEnable BreakKill BreakList BreakSet v
CMSIS-DAP Debugger t1: 0.00091320 sec L]

4.1 To use KitProg3/MiniProg4, CMSIS-DAP, and ULink2 debuggers

1. Select the Device tab in the Options for Target dialog and check that M4 core is selected:

Options for Target 'mtb-example-psoct-gpio-interrupt’ X

Device |Targe1| Outputl Listingl User I C/Cs+ {.ﬂ.CG}I Asm I Linkerl Debugl Util'rtiesl

ISoﬂware Packs LI
Vendor: Cypress Software Pack
Device: CYBCR247BZI-D54 Cortex-M4 Pack: |er955-P5°CG_DFP-1-D-D
Toolset: ARM URL:  hitp-//www keeil com/pack
Search: I
4 CYSCE247BZI-D54 :I PSoC 62 (Perfformance Line): Dual-core Cortex-M4./M0+ MCL series
. with programmable digital and analog peripherals, advanced
€3 _CvaC6247821-D54: Cortex-Mop graphics, CapSense, crypto and secure boot security.

E| CYBCE247BZ1-D54:Cortex-M4
% CVBCE247FDI-D02
i§ CYBCH247FDI-D32
[ CY8C6247FDI-D52 J
[ CVBCE247FTI-D52
% CYBCE247WI-D54
[ CVBCE248A71-52D14

i e
0K I Cancel Defaults Help
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2. Select the Debug tab.

Infineon

Note: To use the ULink2 probe for multi-core debugging, select the CMSIS-DAP Debugger instead of
ULink for each core of the project (CM4 and CMOP).

3. Click the Settings button.

KA Options for Target 'mth-example-psoct-gpic-interrupt’

Device ] Target ] Qutput ] Listing ] User ] C/C++ {ACG}] Asm ] Linker Debug l Litilities ]

" Use Simulator ~ with restrictions Settings * Use: |CMSIS-DAP Debugger
I~ Limit Speed to Real-Time

jl Settings I

Manage Component Viewer Description Files ... |

Iv¥ Load Application at Startup ¥ Run to main() Iv¥ Load Application at Startup ¥ Run to main()
Inttialization File: Inttialization File:
Restore Debug Session Settings Restore Debug Session Settings

|v Breakpoints ¥ Toolbox |v Breakpoirts ¥ Toolbox

¥ Watch Windows & Performance Analyzer v Watch Windows

Iv¥ Memory Display [v¥ System Viewer v Memory Display [v¥ System Viewer
CPU DLL: Parameter: Driver DLL: Parameter:
|SARMCM3.DLL |-REMAF -MPU |SARMCM3.DLL |-MPU
Dialog DLL: Parameter: Dialog DLL: Parameter:
|pcMDLL [pCM4 |[TCM.DLL |pC4
™ Wam if outdated Executable is loaded ™ Wam if outdated Executable is loaded

oK | camcd | Defauts |

Help

4. Onthe Target Driver Setup dialog on the Debug tab, select the following:

e setPortto"SW"
e setMaxClockto"1MHz"
e setConnect to "Normal"
e setReset:
e ForPSoC™6,to"VECTRESET"

e ForPSoC™4, PMG1, and AIROC™ CYW208xx, to "SYSRESETREQ"

e enable Reset after Connect option

Debug ITIEICE ] Flash Download] Pack ]

CMSIS-DAP - JTAG/SW Adapter SW Device

|C‘,'press MiniProg4 [CMSIS-D:j IDCODE Device Name

SWDIO | 3 (x6BAD2477  ARM CoreSight SW-DP
Serial No: [0516198B0223741 @ L

Firmware Version: |2.0.0

o pafow < || ©
@] ,—
M Cocc ke <] | s
02
Debug
Connect & Reset Options Cache Options Download Options

™ Stop after Reset

Connect: {Nomal - Reset:IEECTRESET - I Iv¥ Cache Code I~ Verfy Code Download
v Cache Memory ™ Download to Flash
og Debug Accesses

oK | Cancel

User guide 15
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5.

6. Selectthe Pack tab and check if "Cypress.PSoC6_DFP" is enabled:
CMSIS-DAP Cortex-M Target Driver Setup *
Diebug I Trace I Flash Download ~Pack
Debug Description
Pack: Cypress.PSoCE&_DFP.1.0.0
¥ Enable I~ Enable Flash Sequences
™ Log Sequences: ID:"-.CyP"-tmp"-new"-.KeiIiject"-.CYSCKIT—EEE-";"J'IFI-BT‘-.Erd"-nﬂb-example-psocE-gpio-inter
Configuration: I Edit... |
0K I Cancel Help
User guide 16

Select the Flash Download tab and select "Reset and Run" option after download, if needed:

CMSIS-DAP Cortex-M Target Driver Setup

Debugl Trace Fash Download | Pack I

*

— Download Function RAM for Algorithm
LaRD " Erase Full Chip ¥ Program
_‘Fi % Erase Sectors [ Ve Start:l[b(ﬂBDZS«iDD Size: |0000S000
C oo B[R]
r Programming Algorithm
| Device Size | Device Type | Address Range |
CY8Choo_SFLASH_TOC2 1k On-chip Flash 16007C00H - 16007FFFH
CY8Choo_SFLASH_PKEY * On-chip Flash 16005A00H - 160065FFH
CY8Choo_SFLASH_USER pild On-chip Flash 16000800H - 16000FFFH
CY8Choor_WFLASH 32k On-chip Flash 14000000H - 14007FFFH
CYBCExT_sect256KB ™ On-chip Flash 10000000H - 100FFFFFH
Start:l Size:
Add | Remove |
ok | Cancel | Help

Infineon
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4.2 To use J-Link debugger with PSoC™ MCUs
1. Make sure you have J-Link software version 6.62 or newer.

2. Select the Debug tab in the Options for Target dialog, select J-LINK / J-TRACE Cortex as debug adapter, and
click "Settings":

WA Options for Target 'mtb-example-psoch-gpio-interrupt’ X

Device ] Target ] Qutput ] Listing ] User ] C/C++ {ACG}] Asm ] Linker Debug l Litilties ]

" Use Simulator  with restrictions Settings @ Use: lJ-LINK / J-TRACE Cortex v Settings l
™ Limit Speed to Real-Time
¥ Load Application at Startup ¥ Run to main() ¥ Load Application at Startup ¥ Run to main()
Initialization File: Initialization File:
Restore Debug Session Settings Restore Debug Session Settings

I¥ Breakpoints v Toolbox [v¥ Breakpoints ¥ Toolbox

¥ Watch Windows & Performance Analyzer ¥ Watch Windows

[v Memoary Display v System Viewer v Memary Display ¥ System Viewer
CPU DLL: Parameter: Driver DLL: Parameter:
|SARMCM3.DLL. |-REMAP -MPU |SARMCM3.DLL |-MPU
Dialog DLL: Parameter: Dialog DLL: Parameter:
|pcm.DLL [pCM4 [TCMDLL |pCM4
[~ Wam if outdated Executable is loaded [~ Wam if outdated Executable is loaded

Manage Component Viewer Description Files ... |

0K | Cancel |  Defauts | Help

3. Ifyou see the following message, click OK in the Device selection message box:

Debug lTrace ] Fash Download] ‘
J-Link  J-Trace Adapter JTAG Device Chain
5N: | -

Device: ’— Ty
wwe [ A T

]
P L J
H B

The selected device "CYBCE247EZI-D54: CORTEX-M4" is unknown to this version of the J-Link software.

Flease make sure that =t least the core J-Link shall connect to, is selected.
[ Proper device selection is required to use the J-Link internal flash loaders
for flash downloed or unlimited flash breakpoints.

For some devices which require a special handling, selection of the correct device is important. 1%
User guide 17 002-37570 Rev. *A

2023-06-02



Keil pVision for ModusToolbox™ user guide

Programming/Debugging

4. Select the appropriate target in Wizard:

H SEGGER J-Link V6.62b - Target device settings X
Selected Device: CY8CExx7_CM4 Lite Endian ~ | (Core #0 -
Manufacturer Device Core MNumCores Flash Size RAM Size 2
Cypress CYBChaxb_CM4 Cortex-M4 1 512KB + 32 K. 32KB
Cypress CYBCHb_CM4_sect256KB Cortex-M4 1 512KB + 32 K... 32KB
Cypress CY8CHeT_CMOp Cortex-MD 1 1MB+32KB.. 32KB
Cypress CY8ChaT_CMOp_sect2 56KB Cortex-M0 1 1TMBE +32KB.. 32KB
Cypress CY8CHaT_CMOp_sect236KB_tm  Cortex-MO 1 1MB +32KB.. 32KB
Cypress CYBCET_CMOp_tm Cortex-MD 1MB + 32 KB... 32 KB
CYBCEaT_CM4 _ 1ME + 32 KB.
Cypress CYBCEaT_CM4_sect256KB Cortex M 1MB+32KB.. 32KB
Cypress CY8CHoa_CMOp Cortex-M0 1 2MB +32KB.. 32KB
Cypress CY8CHout_CMOp_sect256KB Cortex-M0 1 2MB + 32KB.. 32KB
Cypress CYB8CEwd_CMOp_sect256KB_t.. Cortex-MO 1 2MB + 32 KB.. 32KB
Cypress CY8CHots_CMOp_tm Cortex-M0 1 2MB + 32KB.. 32KB
Cypress CYBCEa_CM4 Cortex-M4 1 2MB+32KB.. 32KB
Cypress CYBCEA_CM4_sect236KB Cortex-M4 1 2MB + 32 KB.. 32KB
Cypress CYBL10hoo: Cortex-MD 1 128 KB 16 KB v
= P e wan B P ann - J
Cancel
5. Goto Debugtab in Target Driver Setup dialog and select:
e setPortto"SW"
e setMaxClockto "1 MHz"
e setConnectto "Normal"
e setResetto "Normal"
e enable Reset after Connect option
Cortex ILink/ITrace Target Driver Setup X
Debug |T|E|ce I Flash Downloadl
—J-Link / J-Trace Adapter — SW Device
sN:  [sot07s42 -] IDCODE | Device Name | Move
e Iink SWD | @ 0<6BAD2477  ARM CoreSight SW-DP Up |
HW: | viD10  di: I V6.62d Downl
FW:  |J-Link V10 compiled Jan 7 2C
Por - % Automatic Detection 1D CODE: I
5W - " Manual Configuration Device Mame: I
Add | Delete | Update | IR len: I
Cache Options Download Options
Reset:fNomal — ~|l| ¥ CacheCode | | I Verfy Code Dowrload
¥ Cache Memary I™ Dowrload to Aash
r Interface TCP/IP Misc
@ UsB ¢ TCP/P Al R .
IP-Address Part {Auto: 0) Autodetect ik Info |
Sean | 27.0 .0 .1
| | Fing | JLink Crd |
State: ready
ok | Cancel | appn |
User guide 18
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6. Selectthe Flash Download tab in Target Driver Setup dialog and select "Reset and Run" option after

download if needed:

Cortex JLink/JTrace Target Driver Setup

Debug ] Trace Hash Download ]

Download Function

LOAD

RAM for Algorithm
¥ Program

[ Veri
Dot Erase

Programming Algorithm

Start: | (08026400 Size: | 8000

] |

Description | Device Size | Device Type | Address Range |

CYBCHoo_SFLASH_TOC2 Tk On-chip Flash 16007C00H - 16007FFFH

CYBCHoo_SFLASH_PKEY ks On-chip Flash 16005A00H - 160065FFH

CYBCHoo_SFLASH_USER 2 On-chip Flash 16000800H - 16000FFFH

CYBCHoo_WFLASH 3k On-chip Flash 14000000H - 14007FFFH

CYBCHo7_sect256KB M On-chip Flash 10000000H - 100FFFFFH
Start: | Size: |

4.3 To use J-Link debugger with XMC7000 devices

4.3.1 Program set-up instructions

1. Select the Debug tab in the Options for Target dialog, select "J-LINK / J-TRACE Cortex" as the debug

adapter, and click Settings.

(W] Options for Target Target 1'

Device ] Target ] Qutput ] Listing ] User ] C/Ce++ {ACG}] Asm ] Linker Debug l Ltilties ]

" Use Simulator ~ with restrictions

Settings | | & Use: iIJ—LINK /JTRACE Cotex v | |

[~ Limit Speed to Real-Time

Iv¥ Load Application at Startup ¥ Run to main()

Initialization File: Initialization File:

e |] -

Restore Debug Session Settings

Restore Debug Session Settings

¥ Load Application at Startup ¥ Run to main(}

o o |

[v¥ Breakpoints ¥ Toolbox
¥ Watch Windows & Performance Analyzer
¥ Memory Display [v System Viewer

Iv Breakpoints
W Watch Windows
¥ Memory Display

W Toolbox
¥ Tracepoints
v System Viewer

[ Wam if outdated Executable is loaded

[~ Wam if outdated Executable is loaded

CPUDLL: Parameter: Driver DLL: Parameter:
|SARMCM3.DLL |-REMAP MPU |SARMCM3.DLL |-MPU
Dialog DLL: Parameter: Dialog DLL: Parameter:
|DCM.DLL |1:cw|? |TCI'v1.DLL |1:cw|?

Manage Component Viewer Description Files ...

0K

Cancel

Defauilts |

Help

User guide
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2. Onthe Debug tab in the Cortex J-Link/JTrace Target Driver Setup dialog, select "Connect under Reset" on

the Reset pull-down menu, and then click OK.

Cortex JLink/JTrace Target Driver Setup

Debug |Trace | Flash Download |

HW : V4.00 di: I Vi
FW : J-Link Uttra V4 compiled Sep .
Max Clock: % Automatic Detection

—d-Link / J-Trace Adapter ———— ~ 5W Device
SN:  [504403253 -] IDCODE | Device Name | Move
Trs Iink Ultra SWD | @ (x6BA02477  ARM CoreSight SW-DP

Drowry

HE

|0 CODE: I

Auto Clk | Add | Delete | Updatel IR len: I

Port:
ISW j |2 MHz j € Manual Configuration Device Mame; I

Connect & Reset Options Cache Options Download Options ————
Connect: INorrnaI vl Reset: |l - ¥ Cache Code [ Verify Code Download
[~ Reset after Connect Mormal [¥ Cache Memory [~ Dowrloadto Fash
Core
Reset Pin
rInteface ———————— ~ TCP/IP [l gVl e tEr Misc
. Networl Halt atter Boot
& use  TCPAP IP-ag|Hak before Bootloader | o o) Adtodetect | JLink Info |
sean | T27|AD Lk ater Kerel |- [0 fra | sk Cnd |
) Core and Peripherals nd n
State: ready LPC1200

ok | cancel |

Apply

3. Select the Utilities tab in the Options for Target dialog and deselect the Update target before Debugging

check box.

Options for Target ‘Target 1'

Device I Targetl OLrtputI Listingl User I C/C++ {.RCG}I Asm I Linkerl Debug Lhilities

r—Configure Flash Menu Command

¢ Use Target Driver for Flash Programming [ Use Debug Driver

— Use Debug Driver —

Settings | | [ iUpdate Target before Debuaging: |

i Fie: J Ed'rt...l

" Use Extemal Tool for Flash Programming

Command:l

&

Nguments:l

™ Run Independent

r—Configure Image File Processing (FCARM):

Output File: Add Output File to Group:
Source LI
Image Files Root Folder: I [ Generate Listing
OK | Cancel |  Defauts | Help

User guide 20

002-37570 Rev. *A
2023-06-02



Keil pVision for ModusToolbox™ user guide

Programming/Debugging

4.3.2 Debug set-up instructions

Infineon

1. Select the Debug tab in the Options for Target dialog, select "J-LINK / J-TRACE Cortex" as the debug

adapter, and click Settings.

kA Options for Target 'Target 1'

Device ] Target ] Qutput ] Listing ] User ] C/Ce++ {ACG}] Asm ] Linker Debug l Ltilties ]

" Use Simulator

with restrictions

I~ Limit Speed to Real-Time

Settings | | % Use: ||J—LINK/J-TRACE Cortex

j Settings |I

[¥ Load Application at Startup

¥ Run to main{}

[¥ Load Application at Startup

v Runto main()

Initialization File:

Restore Debug Session Settings

| o e ||| — L e |

Initialization File:

Restore Debug Session Settings

[~ Wam ff outdated Executable is loaded

Manage

[v¥ Breakpoints ¥ Toolbox Iv Breakpoints v Toolbox
¥ Watch Windows & Performance Analyzer ¥ Watch Windows ¥ Tracepoints
¥ Memary Display v System Viewer ¥ Memory Display v System Viewer
CPUDLL: Parameter: Driver DLL: Parameter:
|SARMCM3.DLL |-REMAP -MPU |SARMCM3.DLL |-MPU
Dialog DLL: Parameter: Dialog DLL: Parameter:
[cm.DLL [pCM7 |TCM.DLL [pCM7

[~ Wam if outdated Executable is loaded

Component Viewer Description Files ... |

0K

| Cancel | Defaults | Help

2. Onthe Debug tab in the Target Driver Setup dialog:

- Reset pull-down: select

- Download Options: enable "Verify Code Download" and "Download to Flash"

"Normal," "Core" or "Reset Pin"

Cortex JLink/JTrace Target Driver Setup

Debug lTrace ] Flash Download]

SN: 504403253 -

Device: J-Link Ultra
HW : V4.00 di:| V770

FW J-Link Ultra V4 compiled Sep .

J-Link # J-Trace Adapter SW Device

*

IDCODE Device Name

SWD | & x6BAD2477  ARM CoreSight SW-DP

Interface TCPAPH

Part: Max Clock: Ol
[sw  ~| [zwHz  ~| || ©
Auto Clk | | | |
Connect & Reset Options Cache Options Download Options
Connect: |Nomal | Reset: |v Cache Code Iv Verify Code Download
[~ Reset after Connect Iv¥ Cache Memary ¥ Download to Fash

State: ready

# USB (" TCP/AP REIT

IP-
Ki
w 127 | ADI Halt after Kemel

Core and Peripherals
LPC1200

Fese Misc
Hatlt after Bootloade
e Hihet Iij:fore Bootloader | po (auto: 0) Autodetect | JLink Info |
o | JLink Cmd |

0K | Cancel
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4.4 Program external memory
1. Download internal flash as described above.

Notice "No Algorithm found for: 18000000H - 1800FFFFH" warning.

Infineon

2. Select the Flash Download tab in Target Driver Setup dialog and remove all programming algorithms for

On-chip Flash and add programming algorithm for External Flash SPI:

CMSIS-DAP Cortex-M Target Driver Setup

Debug | Trace Fiash Download | pack |

— Download Function RAM for Algorithm
Lopn  © EreseFull Chip ¥ Program

Fi_ % FErase Sectors W Verfy
" Donot Erase |V Reset and Run

Start: I{b:ﬂEDQGdDD Size: |(2<00002000

— Programming Algorithm

CYBCEoor SFLASH_TOC2 On-chip Flash 16007C00H - 16007FFFH
CYBCHoo_SFLASH_FKEY On-chip Flash 16005A00H - 160062FFH
CY8CHoo_SFLASH_USER On-chip Flash 16000200H - 16000FFFH
CYBCEoo_WFLASH On-chip Flash 14000000H - 14007FFFH

CYECHorT_sect256KB On-chip Flash 10000000H - 100FFFFFH

Start: |[b(1GDD?CDD Size: |k<D0D00400

o | [ ]

Help

CMSIS-DAP Cortex-M Target Driver Setup

Debug | Trace Flash Download | Pack |

r— Download Function

% Frase Sectors
Fi " Do not Erase

LORAD " Erase Full Chip W Program

¥ Verfy
¥ Reset and Fun

RAM for Algorithm

Start: I{bd]HDZG-lDD Size: | (k00008000

r— Programming Algorithm

Descrntion = Address Ha

= — —
CYECHooe_SMIF 128 Ex.Flash SFI 1E000000H - FFFFFFFH

Start: |[b:1BDDDDDD Size: |(x02000000

Add | Remove |

Help

3. Download flash.

Notice warnings:

e No Algorithm found for: 10000000H - 1000182FH
e No Algorithm found for: 10002000H - 10007E5BH
e No Algorithm found for: 16007CO0H - 16007DFFH
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4.5 Erase external memory

Infineon

1. Select the Flash Download tab in Target Driver Setup dialog and remove all programming algorithms for

On-chip Flash and add programming algorithm for External Flash SPI:

Debug I Trace Fash Download | Pack I

— Download Function RAM for Algorithm
LORD ¢~ Erase Ful Chip ¥ Progmm
_‘Fi % Erase Sectors W Verfy Start: |(x08026400 Size: |2c00008000
" Donot Emse [ Resetand Run

— Programming Algerithm

Descrption Address Ha

i evice Size D nge
CY8CHoox_SMIF 128M Ext. Flash 5P| 18000000H - 1FFFFFFFH

Start: |[k1RDDDDDD Size: |(<02000000

Add | Remave |

CMSIS-DAP Cortex-M Target Driver Setup X
Debugl Trace Flash Download IF‘ack I
— Download Function RAM for Algorithm
LOAD " Erase Ful Chip  [¥ Program
a_ & Erase Sectos ¥ Verfy Start: IMMDD Size: | (00008000
" Donot Erase ¥ Resetand Run
— Programming Algarithm
CYBCHox_SFLASH_TOC2 On-chip Flash 16007C00H - 16007FFFH
CYBChoo_SFLASH_PKEY On-chip Flash 16005A00H - 160065FFH
CYBChoo_SFLASH_USER On-chip Flash 16000800H - 16000FFFH
CYBChoo_WFLASH On-chip Flash 14000000H - 14007FFFH
CYBChoT7_sect256KB On-chip Flash 10000000H - 100FFFFFH
Start: [Bc16007C00 Size: | 300000400
Add | I Remove I
ok | Cancel | Help
CMSIS-DAP Cortex-M Target Driver Setup X

2. Click Flash > Erase in menu bar.

User guide 23

002-37570 Rev. *A
2023-06-02



o~ _.
Keil pVision for ModusToolbox™ user guide ‘ In f| neon

Multi-core debugging

5 Multi-core debugging

This section explains how to set up multi-core debugging in the pVision IDE.
5.1 Supported debugger probes

e KitProg3 onboard programmer

e MiniProg4

e ULINK2

e J-Link

5.2 Opening pVision multi-core projects

After you create a ModusToolbox™ multi-core application for use with pVision, do the following:

1. Navigate to ModusToolbox™ project directory for one of the cores and double-click project description file
(either *.cprj or *.cpdsc depending on pVision version).

The first time you do this, a dialog may pop-up offering to install missing CMSIS-Pack. Click Yes and the
pack will be installed.

2. Repeat the same process for the CM4/CM7 project(s). This will create and open pVision projects.

5.3 Debugger configuration

Next, configure projects to launch multi-core debugging.

5.3.1 Configure CM0O+ project

1. Goto Project > Options for Target <target_name>, switch to the Debug tab, select the applicable debug
probe (CMSIS-DAP or J-Link) as shown:

7] Options for Target Target 1 X

Device | Target | Output | Lsting | User | C/C++(ACE) | Asm | Linker Debug ]Utilities |

" Use Simulator  with restrictions Settings | | & Use: [[CMSIS-DAP Debugger || Settings
[™ Limit Speed to Real-Time

e [fusing ULINK2, select the CMSIS-DAP Debugger option as the debug probe, because the ULINK2 driver
does not support multi-core debugging.

2. Click the Settings button to configure the target driver.

o Ifyou select the J-Link probe, a pop-up window might display reporting that the device is unknown to
J-Link software.

[ J-Link V7.70e Device Selection ? X

The selected device "XMC72000-E272K8384:CORTEX-MOP" is unknown to this version of the J-Link software.
CQ Plesse make sure that at least the core 1-Uink shal connect to, is selected.
)| Proper device selection is required to use the J-Link internal flash loaders
== for flash download or unlimited fiash breakpoints.

For some devices which require a special handiing, selection of the correct device is important.

e Ifso,click 0.K. and select the device manually in the opened Target device settings dialog. For XMC7200
devices, there will be three aliases, each dedicated to a separate core.
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H SEGGER J-Link V7.70e - Target device settings X
Selected Device: XMC7200-8384_CMOp_tm Litte Endian * | |Core#0 +

=
Manufacturer Device Core NumCeres Flash Siz
V|xmc7200 | V|= te |= ter |

Infineon
Infineon | xMCT200-8384_ CM7_1tm | Cortex-M7 [1 ET=

3. Switch to the Flash Download tab, select the Erase Sectors radio button, and select the Program, Verify,
and Reset and Run check boxes.

CMSIS-DAP Cortex-M Target Driver Setup x

Debug | Trace  Flash Dowrioad | Pack |

Download Function, RAM for Algarithm
Logp | © Erase Full Chip ¥ Program
i * Grase Sectors [ Venly Start: |(x08002400 Size: |(00008000
 DonctErase [ Hesel and Aun

Programming Algorithm
Description | Device Size Device Type Address Range
CYBCRexA_SFLASH_TOC2 1k On-chip Flash 16007C00H - 16007FFFH
CYBCRxA_SFLASH_PKEY Ik On-chip Flash 16005A00H - 160065FFH
CYBCEaxA_SFLASH_USER p3 On-chip Flash 16000800H - 16000FFFH
CY8CEaA_WFLASH 32 On-chip Flash 14000000H - 14007FFFH
CY8CExxA_sect256KB M On-chip Flash 10000000H - T01FFFFFH

Start: | Size

4. Click OKto close the Target Driver Setup dialog.

5. Next, configure the project so that it also programs other image(s) from the CM4/CM7 project(s). Do this
using the *.ini file.

a. Create a new empty file named load_cmx.ini and save it inside the CMO+ project directory.
b. Addaroabcommand with a path to the CM4/CM7 images. For example:

LOAD "..\\proj cm4\\proj cmé4 Objects\\proj cmd.axf"
c. Add as many LoaD commands for all the CM4/CMT projects as you have.

6. Go to Project > Options for Target <target_name>, select the Utilities tab, and specify the created
load_cmx.ini file in the InitFile edit field.

%] Options for Target ‘Target 1' *

Device | Target | Output | Listing | User | C/C++ (ACE) | Asm | Linker | Debug  Utiities
Configure Flash Menu Command

&% Use Target Driver for Flash Programming ¥ Use Debug Driver
— Use Debug Driver — Settings [V Update Target before Debugging

Ilml File: |.Noad_cmx ini I D Edit

" Use Extemal Tool for Flash Programming

Command:| ]

Y =il

7. Switch to the Debug tab, and click the Settings button.
The configuration settings are different for CMSIS-DAP/ULINK2 and J-Link. Refer to the following sections
for the applicable options:
e CMSIS-DAP/ULINK2 Target Driver Setup - Use the following options:
e Port: SW
e MaxClock: 1 MHz
e Connect: Normal
e Reset: SYSRESETREQ
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CMSIS-DAP Cortex-M Target Driver Setup X
Debug hrace | Flash Download | Pack |
CMSIS DAP - JTAG/SW Adapter— - SW Device
= =] IDCODE Device Name
SWDIO | @ (x6BA02477  ARM CoreSight SW-DP
Seral No: [181201A5002494( © e |
Fimware Verson: [200 Dawr
2 Porf[sw  +| ¢
ol —
Max Clack{[1MHz - ]|
01
Debug
Connect & Reset Options Cache Options Download Options
Connect{|Nomal || Reset| |svsREsETREG ~ || | ¥ Cache Code I” Verify Code Download
[# Reset after Comnect ¥ Cache Memory | | [ Downloadto Fash
I Log Debug Accesses | Stop after Reset

e J-Link Target Driver Setup - Use the following options:
e Port: SW
e Maxclock: 1 MHz
e Connect: Normal

e Reset: Normal

Cortex JLink//Trace Target Driver Setup x

Debug ITrace I Flash Downluad]

JHink / J-Trace Adapter SW Device
LV 0 07227] =] IDCODE Device Name

Device: | ok SWD | & 0x6BA02477  ARM CoreSight SW-DP J
Hw: [vioan  di: [ viste J

FW:  |J-Link V10 compiled Jul 22 20

Pogt L= o Cl
: ——
Auto Cl | | | |

Conne: Cache Options Download Options

Cunnedl Normal - IRESE(I Normal hd I [¥ Cache Code [~ Verify Code Download

¥ Reset after Connect [¥ Cache Memory [ Downloadto Fash

Interface TCPAP Misc

Network Settings
@ USB ¢ TCRAP
IP-Address Por (Auto; () | futodetect daix 15
Sean 127 . 0 0 | 5 0
[ 2 JLink Cmd

State: ready

oK Cancel | ‘

That completes configuring the CM0+ project. The next step is to configure CM4/CMT project(s).

5.3.2 Configure CM4/CM7 project

1. Goto Project > Options for Target <target_name>, switch to the Utilities tab and deslect the Update
Target before Debugging check box.

Device | Target | Outpust | Listing | User | C/C++ (ACE) | Asm | Linker | Debug  Utites |

Configure Flash Menu Command

¥ Use Target Driver for Flash Programming I¥ Use Debug Driver

— Use Debug Driver — Settings | I ™ Update Target before Debugging |
int Fle: [-\pror_om7_0in] L] e

" Use Extemal Tool for Flash Programming

Command: ‘ J

2. Switch to the Debug tab, select the applicable debug probe (CMSIS-DAP or J-Link).

e [fusing ULINK2, select the CMSIS-DAP Debugger option as the debug probe, because the ULINK2 driver
does not support multi-core debugging.

3. Click the Settings button to configure the target driver.
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Infineon

4. Onthe Target Driver Setup dialog, switch to the Flash Download tab, select the Do not Erase radio button,

and deselect the Program, Verify, and Reset and Run check boxes.

CMSIS-DAP Cortex-M Target Driver Setup X

Debug | Trace Flash Download ]Pack |

Download Funcfion RAM for Algorithm
Liap | ¢ Ermse FulChip [ Brogram
i " Erase Sectors [~ Verify Start: | (08026400 Size: |0x00008000
@ DonotErase [~ Resetand Run

Pragramming Algorithm

Deseription |_Device Size | Device Type | Address Range [

CY8CEuA_SFLASH_TOC2 Tk On-hip Flash 16007C00H - 16007FFFH

CY8CEuA_SFLASH_PKEY * On-<hip Rash 16005A00H - 160065FFH

CYCEuA_SFLASH_USER X On-chip Flash 16000800H - 16000FFFH

CYACHuA_WFLASH 3% On-chip Flash 14000000H - 14007FFFH

CYCHuA_sect256KB M On-chip Flash 10000000H - 101FFFFFH
Start: | Size: |

5. Switch to the Debug tab.

The configuration settings are different for CMSIS-DAP/ULINK2 and J-Link. Refer to the following for the
appropriate options:

e CMSIS-DAP/ULINK2 Target Driver Setup - Use the following options:

Port: SW

Max Clock: 1 MHz
Connect: Normal
Reset: VECTRESET

Reset after Connect check box: deselected

CMSIS-DAP Cortex-M Target Driver Setup

Debug wTrace | Flash Download | Pack |

CMSIS-DAP - JTAG/SW Adapter SW Device

[Any | IDCODE Device Name

SWDIo 77 =
Serial No: [181201A5002¢341 OUEERy eI
Firmware: Version: [20.0
o Pat:[sw  +| o

Max Clock: [ 1MHz hd

(@) ,7

Debug

L ot A Dasst Ooh Cache Options Download Options
ICunnecl [Momal _~| Reset:[VECTRESET =[] | ¥ Cache Code [ Verfy Code Download
T ¥ Cache Memory | | [~ Dowrload to Flash

[ Log Debug Accesses [ Stop after Reset

Cancel Help

e J-Link Target Driver Setup - Use the following options:

User guide

Port: SW

Max Clock: 1 MHz
Connect: Normal
Reset: Core

Reset after Connect check box: deselected
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Cortex ILink/ITrace Target Driver Setup

Debug | Trace | Flash Download |

Connect ‘Nurma\ j Reset: |CDrE
I~ Beset after Connect

J-Link / J-Trace Adapter SW Device
SN:  [50107842 1 IDCODE Device Name
Device: [ JLmk SWD | @ 0x6BAD2477  ARM CoreSight SW-DP J
HW: [ViD10 di: [ v77te J
FW:  [I-link V10 compiled Jul 22 20

Port: Max Clock: o

sw o] frwwe ]| ©

Auto Ok | \ \ \
Connect & Reset Options Cache Options Download Options
~I|| ¥ Cache Code I~ Verfy Code Download

[¥ Cache Memory ™ Download to Alash

Interface TCP/P Misc
p— Network Settings
= USE; ¢ TCPAP
Py Port (o) | Adodetect JLink Infa
Scan | 127 1 . | D
JLink Cmd
State: ready
0K Cancel |

6. Click OKto close the Target Driver Setup dialog.

7. Savethe project(s).

5.4 Launching multi-core debug session

Infineon

To launch a multi-core debug session, all your pVision projects must be opened in separate IDE instances.

1. Open a pVision IDE session with the project for the CM0+ core and start debugging by pressing Debug >
Start/Stop Debug Session. This will program all images, reset the target, and halt at the beginning of the

CMO+ projectmain ().

2. Repeat the same process for the CM4/CM7 core(s). This will attach the running CM4/CM7 core that will be

spinning in the boot code until the CMO+ project starts it.

Note: Ensure both projects are built before launching a debug session.
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For dual-core MCUs, the projects will appear similar to these images:

a

Fie Eait View Piojed Flah Debug Periphersi Tools SVCS Window Heln
TS d | s -3 - "
HEO MErEo ¢ D0 E SR D300 B

Registers 9 O Disassembly

[ woeting FLASH SIZE

YERea-

& @8-

%]

Filt Edt View Pojedt Flash Debug Pengherals Tools SVCS Window Helg

Sda s k- "
L IRt BN P R= - R R R RS

0 O Dissssembly

- 1| 8 pasH_cmoe sze

o
&

Registers

P

=]

OmOSFA

Fagitar Ve Ox1000043A 0SFA

) gsvspm.

CY_CORTEX M4 APFL ADDR must be updated if CM4 memozy

vaRs@-ecsa- @

FOP 17, pcl

Ox1000AASA BDEO
i

(7,12}

MsP

3 B caStack - Locals
CiV\mbw-psccé-malti-core) \Multicoze_Empty APp\\PZod

Name

% main 0c1000042C

< >

Location/Value

Trpe
int 10

he device and board per.

sp_inie() ¢
© != CY_RSLT_SUCCESS)

CY_ASSERT (0):

Cy_GPIO_Fin_FastInit (GRIO_PRTLL,

B @ Calf Stack + Locals

C6-MULT1-Core\\MuLTicore_ENDTY_APPANDIO] ~ | Name
n.c\49

5 % man
@ result

< >

ASSIGN BreakDisable Breakinable BreakEill BreakList

‘ Facan staek + toeats [T e

Debug: Client Mode

CMSIS-047 Debugger

. CY_GPIO_DM_STRONG,

. BSIOM_SEL_GPIO

>

L
Location/Valkue Type
0 10008A9C intf)
OxCIZABEFC auto - wint

ASSICN BreakDisable BreakEnable BreakKill BreakList

";hmu stack + Loeals [ [ Memo

CMSIS-DAP Debugger

The left side of the screen shows a pVision IDE instance attached to the CM0+ core. The right side shows the
CM4 core has not started yet. Once the Cy SysEnableCM4 () function on the CMO+ core has been executed,
the CM4 will start executing its application. You can step through the code by switching back and forth between

the two pVision IDE instances.
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6 Patched flashloaders for AIROC™ CYW208xx devices

To enable support for different QSPI settings, the ModusToolbox™ QSPI Configurator patches flashloaders and
stores files for them in the application directory. When exporting such applications to Keil uVision, these
patched flashloader files must be copied into the appropriate directory.

1. Copy the CYW208xx_SMIF.FLM file.located in the <app-dir=\libs\<Kit-
Name=>\COMPONENT_BSP_DESIGN_MODUS\GeneratedSource directory.

2. Paste the flashloader file to the C:\Program Files\IAR Systems\Embedded Workbench
9.0\arm\config\flashloader\Infineon\CYW208XX directory.

3. Also, to use the SEGGER J-Link debugger, paste the CYW208xx_SMIF.FLM file to the C:\Program
Files\SEGGER\J-Link\Devices\Cypress\catlb directory.
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